Focus
Virtual Studio

Video & Audio
Settings
Revision as of August 26, 2010
VS 1.63

Copyright © SoftLab-NSK Ltd.

Table of Contents
1

INTRODUCTION ............................................................................................ 3

2

CONFIGURATION OF FD300 BOARDS FOR WORKING IN STUDIO .................. 4

2.1

Audio Settings ........................................................................................... 4

2.2

Video Settings ........................................................................................... 5

2.2.1

Setting Input Video Signals ....................................................................... 5

2.2.2

Setting Output Video Signal Mode .............................................................. 5

VIDEO SIGNALS .................................................................................................... 7
3

SETTING VIDEO SIGNALS IN THE HOTACTIONSLITE APPLICATION .............. 9

3.1

Setting Input Video Signals....................................................................... 9

3.2

Creating Rear Projection of Input Video Image....................................... 11

3.3

Setting Output Video Image .................................................................... 15

4

ROUTING AUDIO VIA EXPANSION BOARD FD300 ....................................... 18

Video & Audio Settings

1 Introduction
This document describes the video and audio settings for the signals connected to the Virtual Studio in
its main application HotActionsLite. Since the input/output of the video and audio data in the Virtual
Studio is based on the FD300 board, the setting is possible only when the FD300Drivers software is
installed in the operating system. To work with HD SDI video signals, the Virtual Studio also require
the installation of the appropriate software for Aja XENA 2Ke: AJA_Windows_Software-4.2.0_x86.msi.
Before setting signals in the HotActionsLite application, configure the FD300 board in the
FD300 Configuration application: specify the parameters of the audio playback on the audio device
selected for this in the operating system (see Section 2.1). If the input video signals and the output of
the resulting image in the Studio (digital SDI or analog signals) are provided by the FD300 board,
configure their parameters in the FD300 Configuration program: specify the format, enable using
Direct Show filters, specify the output video signal type and the genlock mode. These settings are
described in Section 2.
The current version of the document covers the VSHotActionsLite 1.63 and FD300 Drivers
ver. 5.01.350 software.
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2 Configuration of FD300 Boards for Working in Studio
Before working with video and audio signals in the HotActionsLite application of the Virtual Studio,
configure the operation parameters in the FD300 Configuration application (if on the FD300 board).
The audio playback settings are performed for the audio signal output board (Section 2.1). The
appropriate settings for video signals, digital (SDI) and analog, are described in Section 2.2.

2.1 Audio Settings
Working with audio in the Virtual Studio is performed, as a rule on the output board, that is, on the
board with the largest logical index L in the Boards’Indexes list in the FDConfig window.

Figure 1. Setting audio on the output board in the FDConfiguration application.

One of the output devices of the board is selected as the device used in the operating system by default
to play audio. To do so, select Settings > Control Panel > Sounds and Audio Devices from the
Start menu. The Sound and Audio Devices Properties dialog box opens. Select one of the output
audio devices of the output board from the Default device drop-down list in the Sound playback
area of the Audio tab. As a rule, selected is the first one (e.g., FD300 Output 1 B3).
The Disable audio devices option in the Sound tab of the FDConfig window must be unchecked for
the output board. Select the number and type of the input and output audio devices on the board from
the Audio device type drop-down list in the same tab. The Internal processing sample rate
parameter determines the audio sample rate (Section 4); the Allow low level audio/video
synchronization option enables low-level audio and video synchronization. The Digital output
type drop-down list is used to select a type of the audio signal on the digital output (if enabled). For
more details about the audio setting parameters, see section 3 of FDConfiguration_User’s Guide.
When the parameter settings for working with audio signals connected to the board are complete,
further adjustment is possible in the FD300 Sound Control application. The application is discussed in
FD300 SoundControl_User’s Guide. To open the routing dialog box Sound Configure in the Virtual
Studio (HotActionsLite application), click
or select the appropriate command from the Tools
menu. For a detailed description of the dialog box, see Section 4 of this document or Sound
Configure_User’s Guide.
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2.2 Video Settings
2.2.1 Setting Input Video Signals
When working with video signals on FD300 boards, select a TV Standard for the video signals that
come to the board (PAL, NTSC, or others) from the TV Standard drop-down list in the Format tab
for each of the boards, indicated in the Boards'Indexes field of the FDConfig window as Fwd 1,
Fwd2 and so on. The Image Size drop-down list in the same tab is used to select the effective
horizontal resolution – FullFull (720 pixels) or HalfFull (360 pixels).

Figure 2. Setting parameters of video signals connected to FD300 boards.

Working with the connected video signals in the Virtual Studio (HotActionsLite application) is
performed using a Direct Show filter. So, enable the A/V Capture Filter option (for each board with
connected video signals) in the Use Direct Show filters area of the Advanced Settings dialog box
(Figure 3). To open the dialog box, click the Advanced button in the FDConfig window.

Figure 3. Setting the video signal output from the FD300 board using a Direct Show filter.

2.2.2 Setting Output Video Signal Mode
To output the resulting video, the Virtual Studio uses the board with the largest logical index L in the
Boards’Indexes list in the FDConfig window. The output video parameters are specified for it in the
Output tab.
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Figure 4. Setting the Studio output video signal in the FDConfig window.

The Video Output Switching drop-down list is used to select an output mode for the data that come
to the output encoder. This may be video data from the Internal video mixer or from the external
Digital bus.
 Internal -> Analog output – coming to the analog output are the mixer data; the external bus
data are not used.
 Internal -> Analog output + Digital bus – coming to the analog output are the mixer data. The
same data are fed to the digital bus operating in the transmission mode; the device connected to the
bus must operate in the reception mode. May be used to provide an SDI output.
 Digital bus -> Analog output – coming to the analog output are the external digital bus data; the
internal mixer data are not used.
The Analog Video Output drop-down list is used to select a combination of analog video signals that
are to be fed to the board output.
Connecting the video signal receivers is performed via a switching device connected to the board. This
may be a cable set or Breakout Box (see description in section 8 Appendix of HotActionsLite_User’s
Guide). For such connections, the devices have four connectors: CSYNC/CVBS, Y/GREEN/LUMA,
U/BLUE/CVBS, V/RED/CHROMA. Table 1 describes the video signals from the
Analog Video Output drop-down list (Figure 4) and gives the correspondence between the signals
and the connectors of the switching device connected to the output board FD300. The Table contains
the following symbols:
 CVBS – composite signal;
 Luma, Chroma – components of Y/C (S-video) signal;
 Y, U, V – components of YUV component signal;
 R, G, B – components of RGB component signal;
 Sync – sync pulse signal;
 s – presence of sync pulse in the corresponding component;
 ns – absence of sync pulse in the corresponding component.
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Switching Device Connectors

Video Signals

CVBS x 3

RED

BLUE

GREEN

CVBS

V/Chroma

U/CVBS

Y/Luma

CSYNC

CVBS

CVBS

CVBS

Chroma

Luma

CVBS

Three composite signals
Y/C+CVBS

Y/C signal (Luma/Chroma) and composite signal
YUV+CVBS

V

U

sY

CVBS

V

U

Y

Sync

R

B

G

Sync

V

U

Y

sKey

Component signal YUV and composite signal
YUV+Sync

Component signal YUV with a sync pulse in a
separate channel
nsRGB+Sync

Component signal RGB with a sync pulse in a
separate channel
YUV+sKey

Displayed are fill and key.
Fill signal in the YUV component signal format
without Y synchronization
Key signal in the composite signal format

Fill

V

ns(Key onY)UV+sY

Displayed are fill and key.
Fill signal in the YUV component signal format, Y
synchronized
Key signal in the composite signal format without
sync pulse

U
Fill

R

nsRGB+Key

Fill

Displayed are fill and key.
Fill signal in the RGB component signal format
without G synchronization
Key signal in the composite signal format

Key
Fill

B
Fill

Key

G
Fill

Chroma

ColorBarY/C+CVBS

Fill

Key

sY
Fill

sKey
Fill

Key

Luma

CVBS

Displayed is the color-bar pattern.
Y/C (Luma/Chroma) signal and composite signal
ColorBar YUV+CVBS

V

U

sY

CVBS

R

B

G

Sync

Displayed is the color-bar pattern.
Component signal YUV and composite signal
ColorBar nsRGB+Sync

Displayed is the color-bar pattern.
Component signal RGB with a sync pulse in a
separate channel
incorrect signal on the analog output

Double SDI

Used only for SDI option when displaying fill and
key
Table 1. Combinations of analog video signals that are to be fed to the board output.

The Analog Video Output drop-down list contains all the possible configurations for the current
Studio configuration.
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The Source drop-down list in the Genlock Internal Video area of the Output tab in the FDConfig
window (Figure 4) is used to select a Genlock mode for the video output board:
 Master – the output video signal formed by the board internal clock generator is not
synchronized to an external video signal;
 Line A – the output video signal is synchronized to the video signal selected in the Input
drop-down list of the Line A tab;
 Line B – the output video signal is synchronized to the video signal selected in the Input
drop-down list of the Line B tab.
The Delay slider is used to set the video delay value (in milliseconds) to compensate a delay when the
signal passes through the cable. The default value is 0.
The X offset and Y offset sliders are used to set the horizontal and vertical offset of the video image
relative to the sync signal. The default values are 0.
Sc Phase – delay of the color subcarrier phase of the sync signal. Used to synchronize the composite
signal. The default value is 0.
Other settings for the FD300 boards that are performed in the FDConfig window are described in
FDConfiguration_FD300 Board Settings_User’s Guide.
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3 Setting Video Signals in the HotActionsLite Application
3.1 Setting Input Video Signals
To set the input video signals in the Virtual Studio main application HotActionsLite, open the Video
Configure dialog box. To do so, click the Live Video Configure

button on the Live Action

toolbar, or select the Video Configure... command in the Tools
menu, or press F9 on the keyboard.

Figure 5. Dialog box for setting the input video signals in HotActionsLite.

The Stream drop-down list in the Input Source area contains the names of the video streams that
can be created in the application: LIVE_1, LIVE_2, and so on. Initially, the streams has no connected
video signals – <none> indication. Select a video stream from the Stream drop-down list and assign
to it an input device from the Device drop-down list. Now the assigned device is indicated next to the
stream name (Figure 6).
There are two items in the Device drop-down list for the input channels of each FD300 board installed
in the system: SLTM DShow Video Capture board and SLTM DShow Video Line B Capture board.
For Aja XENA boards (HD stream input devices), there are also two input channels in the drop-down
list: Aja Capture Filter board channel 1 and Aja Capture Filter board channel 2.
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Figure 6. Drop-down list of input devices for the connected video signals in HotActionsLite.

The Fields drop-down list is used to select a field order for the specified video signal:
Auto – according to the data that come from the decoder;
None (Progressive) – progressive scan mode (selected when working with a video signal source that
operates in the progressive scan mode);
Upper field first;
Lower field first.
Clicking the Options button in the Input Source area opens the Properties dialog box (Figure 7)
used to specify the input video parameters, since some of them are changeable. For example, it is
possible to select a connector index of a video source (connected to the switching device of the
selected FD300 board) from the Input drop-down list in the Input tab. For more details about the
switching devices and connector indexes, see section 8 Appendix of HotActionsLite_User’s Guide.
The sliders in the Input tab of the dialog box are used to adjust the input video parameters: Hue,
Saturation, Brightness, Contrast, Y gain, U gain, V gain, Y/C Delay. For component signals,
adjusted are only Y gain, U gain, V gain, the other settings being used for composite and Y/C video
signals. Click Default to restore the defaults.

Figure 7. Parameters of the input video signal received from the FD300 board in the Input and Filtering
tabs of the Properties dialog box.

The Filtering tab parameters are available only if the Deinterlace and filtering support option was
previously enabled in the Advanced Settings dialog box (Figure 3). Then, you can select a field
order from the Fields Order drop-down list:
Lower First – lower field first;
Upper First – upper field first;
Deinterlace – progressive scan mode (all the lines of each frame are drawn in sequence).
The Enable MFilter option enables the median filter for filtering video.
The MFilter Y Level and MFilter UV Level spin boxes are used to control the filtering degree by the
luminance and chrominance components respectively (possible values from 0 to 31).
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The Image Format drop-down list in the Advanced tab (Figure 8) is used to select the input video
format. If selected is UYVY, you can flip the image by enabling the UYVY Vertical Flip option.

Figure 8. Parameters of the input video signal received from the FD300 board in the Advanced and
Statistics tabs of the Properties dialog box.

The Statistics tab contains some other input parameters: Frame Format, Frame Rate, Captured
Frames, Dropped Frames, Sound Sample Rate, and others.
When selected in the Device drop-down list is an HD input channel of the XENA Aja board (Figure 6),
clicking the Options button opens a dialog box that contains the input device properties. Clicking the
Format button opens the Properties dialog box (Figure 9) that contains the video format properties
of the XENA Aja input video channel:
Video Format – resolution, scan mode, and frame rate;
Video Source – signal type (Digital or Analog);
Four CC – encoding format.

Figure 9. Dialog box for selecting parameters of video signal input via the XENA Aja board channel.

3.2 Creating Rear Projection of Input Video Image
Select an input device (from the Device drop-down list) for the video stream and specify its
parameters in the Properties dialog box (Figure 7 – Figure 9), and you can see the received image in
the Preview window. The Preview area contains three tabs: Result, Mask, and Input. In the Input
tab, the image is displayed as is, as it comes from the connected video source. Displayed in the other
tabs (Mask and Result) are the created rear projections of the image: colors that will be displayed as
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is, are separated, and the others are substituted with pixels completely or partially transparent. To
configure the rear projection, use controls in the right part of the dialog box. If the image rear
projection is not formed (Use Color Keying check box is unchecked), the Preview window in all the
tabs displays the image as is.
When creating the rear projection, you form a black-and-white frame image that is mask. Pixels
substituted with transparent pixels are displayed black (so-called background), and those unsubstituted
that will remain unchanged are displayed white (actor). The mask is displayed in the Preview window
of the Mask tab. (Figure 10). The Result tab window displays a resultant image, which is the result of
adjusting the rear projection. For the background, you can specify a graphics image. To do so, click
the

button under Background and select the file you want in the Open dialog box. Clicking

the
button opens a color selection dialog box, and clicking the
checkerboard pattern for the background.

button specifies a

Figure 10. Initial mixing mask of the actor, which is a result of creating the rear projection, and the actor
on a single-color background.

The Crop area, which is on the right of the Preview window is used to specify the frame cropping
values (non-display areas): top, bottom, left, and right cropping values respectively as the spin boxes
are in the area. The Feather spin box is used to set the smoothness of transition from non-display
areas of the screen to displayed areas. The Corners spin box is used to set the corner cropping.
Clicking Auto enables the cropping self-adjustment. Checking
enables the area
settings; unchecking the checkbox disables all the frame croppings.
To set the chromakey (rear projection) parameters, use the areas in the lower part of the window. To
use the simplest way to set the parameters, automatic, click the Auto button next to the Use Color
Keying check box. Checking the
check box enables all the chromakey settings. The
result is now displayed in the Mask and Result tabs of the Preview area (Figure 10).
The chromakey array is adjusted in a color space (RGB or YUV). The Color Space area ot the dialog
box contains the cross section and longitudinal section windows of the YUV space (Figure 11). All the
changes in the substituted and non-substituded colors in the frame are displayed in the section planes
in the Mask Configuration tab.
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Figure 11. YUV color space sections in the Video Configure dialog box.

Geometric figures highlighted in lighter colors outline the sections created in the RGB color space.
Areas outside the figures do not exist in the RGB color space.
To open the context menu, place the cursor over the color section plane and right-click. Use the menu
commands to scale the image. To zoom the image in the two windows, click over the window and use
the scroll wheel.
When adjusting the chromakey, there are used three areas in the color space:
1. colors that will be substituted with completely transparent pixels. The virtual scenery objects
will be seen in the frame behind the pixels instead of the colors. Therefore, the substituted
colors of the frame are referred to as background colors.
2. colors that will not be substituted in the frame. Such colors are referred to as the actor colors.
3. color transition from the actor colors to the background colors. Such color pixels will be
substituted in the frame for pixels with partial transparency.
The borders of the areas are shaped like ellipses with a common center. The ellipses are elongated
along the brightness axis (Y). They form an internal area (background colors) and external (actor
colors). Between the internal and external areas, there are colors of the transition from the background
color to the actor colors. The common center (a point in the color space) is specified by the Red,
Green, Blue parameter values in the Background Color area. The center point can also be specified
in the color selection dialog box. To open the dialog box, click the color button in the Background
Color area. Or click Pick and mark the necessary color point in one of the Preview or Color space
windows. The point specifies the center coordinates of the color area that will be removed from the
frame – the background colors. That is such color pixels will be substituted for transparent pixels. The
substituted colors area is ellipsoid-shaped, the ellipsoid being elongated along the brightness axis
(Figure 11). The brightness axis in the YUV space is Y, therefore it is convenient to perform
subsequent setting operations in the YUV coordinates.
The С In, С Out, Y in spin boxes in the Ellipses area are used to specify the area sizes for the colors
that will be substituted in the frame with transparency (background and color transition) and colors
that will be displayed in the frame (actor).
С In – radius (in UV) of the area (in the YUV color space) of the colors that will be substituted in the
frame with transparent pixels : background colors.
С Out –radius (in UV) of the area (in the YUV color space) that bounds the colors of the background
(that will be substituted with transparent pixels) and the colors of the color transition area. Besides the
colors substituted for complete transparency, the frame will contain the color transition that is pixels
substituted for pixels partially transparent. The С Out parameter marks the border of the area in the
YUV color space outside which all the colors will remain in the frame as is, that is its pixels will not
be substituted for completely or partially transparent pixels.
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Y in –half-height Y (half-axis size) of the area (in the YUV color space) of the colors that will be

substituted in the frame with transparent pixels: background colors. The Y out parameter is calculated
automatically, and the Y out area is displayed along with the Y in area in the corresponding window.
The sizes of the color areas can be changed not only by changing the С In, С Out, Y in parameter
values, but also by dragging their borders with the cursor in the windows of the Mask Configuration
tab in the Color Space area. When placing the cursor over the area border, it changes to
, then you
can drag the border with the left mouse button pressed.
Sometimes, when adjusting chromakey, color blending areas may occur on the edges actorbackground (noises), which can be removed by mask filtering (Figure 10).
If select Simple from the Mode drop-down list in the Alpha Correction area, the spatial filtering
parameters of the mask in the frame are available.
The Alpha Min and Alpha Max parameters are used to restore the mask contrast thus removing
noises in the frame. If a pixel opacity value is less than Alpha Min, the pixel will be displayed in the
frame as completely transparent (opacity value 0). If the opacity value exceeds Alpha Max, the pixel
will be displayed completely opaque (opacity value 255). Values in the range between Alpha Min and
Alpha Max are linearly interpolated. Visually, this looks like shrinkage of the actor’s silhouette.
The Edge parameter is used to adjust cropping the edges of the actor mask (meaning by “actor mask”
colors that will be displayed in the frame as is), the border line being the mean value of the pixels in
the area whose size is specified in the Size spin box on the right.
The Gauss parameter is used to adjust the actor mask blur by Gauss filtering. The blur degree is
calculated as the mean value in the area whose size is specified in the Size spin box on the right.
The Color Correction area is used to adjust the color correction. To perform color correction, specify
the colors (in the actor-background color blending areas) that are to be corrected, that is substituted for
other colors, not for transparency now. Most often, color correction is necessary to remove actorbackground color blending in color transition areas in the frame: reflections, thin objects, object edges.
Therefore color correction is performed after the areas of colors that will be substituted for
transparency and of colors that will remain unchanged have been already specified (that is after the
Red, Green, Blue, C In, C Out, Y in parameters have been specified).
Since we are going to specify colors that will be substituted for other colors, all the correction
operations are performed now only in the UV color plane.
The correction is adjusted using the Angle “+” and Angle “-” parameters – rotation angles of two
respective rays that part from the ray coming from the origin of coordinates through the background
center, which is specified by the Red, Green, Blue parameters. The ray specified by the Angle “+”
angle (produced by counterclockwise rotation from the origin-background ray) selects the area where
all the colors will be modified to the ray colors. Likewise, the ray specified by the Angle “-” angle
(produced by clockwise rotation from the origin-background ray) selects the area where all the colors
will be modified to the ray colors. All the changes are reflected in the window of the Color
correction tab in the Color space area. It is also possible to correct the actor colors by rotating the
rays directly in the window with the cursor. When placing the cursor over a ray, it changes to
,
then you can rotate the ray with the left mouse button pressed.

14

Video & Audio Settings

98º
114º

Figure 12. Setting color correction parameters of the video image.

For example, for the correction of green colors in the frame, specifying Angle “+” as 114 means
modifying some of the colors to blue (the color correction ray rotates to the blue area), and specifying
Angle “-” as 98 means modifying the other part of the green colors to red (the color correction ray
rotates to the red area).
To completely switch off color correction, set Angle “+”, Angle “-” to 0. The larger the angle values
specified, the vaster the area of corrected colors.
The black points on the color planes (Figure 11, Figure 12) mark clusters of the statistically most
numerous color pixels that are in the frame. The degree of a pixel transparency on the color planes
reflects the number of pixels of the marked color in the frame. The more opaque (blacker) is a pixel of
a certain color on the color plane, the more pixels of the marked color are in the frame. By sliding the
UV Statistics and Y Statistics controls that are under the UY and Y color planes, you can display the
color distribution statistics in the frame more readable (when the slider positions are close to 100) or
hide it completely (the sliders are set to 0).

3.3 Setting Output Video Image
The output video settings of the resulting image in the HotActionsLite application are specified in the
Render Options dialog box. To open the dialog box, press F11 on the keyboard or use the Render
command of the Options menu in the Render Output window.
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Figure 13. Dialog box for setting the resulting output image of the Studio.

The General area of the dialog box is used to specify the general parameters of the resulting output
image.
The Output Device drop-down list is used to select an output device to render the resulting video
image of the Studio. The list may contain:
Display 1:… (the name of the monitor connected to it) –the Studio operation result will be rendered by
the video adapter;
Display 2: DVM62 - rendering via the connected device DVM62 for the subsequent conversion of the
video signal to HD-SDI format (described in section 7 of HotActionsLite_User’s Guide) or by the
monitor connected to the second output of the video adapter;
External Device: FD300 #1, External Device: FD300 #2, External Device: FD300 #3 (according to
the number of FD300 boards installed in the system) – the image will be rendered by the selected
FD300 board; the board number must match the logical index L of the output board in the
FDConfiguration application (Section 2.2.2, Figure 4). As a rule, it is the largest number.
Display Format – amount of bits allocated for each color component R…, G…, and B… from the 32.
Display mode – image format and the refresh rate.
Output aspect – image proportions (pixel aspect ratio) – Auto (matches the monitor settings), 4:3,
16:9 or Square pixels (1:1).
The Advanced area contains parameters for fine tuning the image output: in the window mode
(Windowed) and full-screen mode (Fullscreen).
Back Buffer Format – image encoding format in an amount of bits for each color component (RGB);
Stencil Format – amount of bits from the 32 allocated for the Z order (D24) and used to store an
object number in the scene (X8);
Present Interval – frame refresh ratio. At the DEFAULT value, the ratio is equal to the monitor
horizontal scan rate as well as at ONE. The ОNЕ mode differs from DEFAULT in greater precision
and larger amount of resources used. In the IMMEDIATE mode, the frame is rendered on the monitor
irrespective of its horizontal scan rate, the output time being equal to the full rendering time.
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Multisample Type – smoothing mode when rendering. When selected NONMASKABLE,
4_SAMPLES, or 8_SAMPLES, the smoothing degree can be specified by the Multisample Quality

slider below. The recommended value is 7 in the 4_SAMPLES mode.
Back Buffers Count – number of half-frames buffered before rendering.
The Device Type drop-down list is used to select a device that will be used for image rendering.
Hardware – video card graphics accelerator, Reference – the image will be rendered in one of DirectX
modes (that is the motherboard CPU will be used).
Vertex Processing – geometric transformation means selection:
Software – transformations are performed by the CPU. Recommended when working with graphics
processors of not very high performance and/or with scenes with a large number of dynamic objects
(e.g. using morphing).
Hardware and Pure hardware – transformations are performed by the graphics processor of the video
card, but when selected Pure hardware, the data transition of the transformation results is impossible,
which allows to optimize the process in the best way. Recommended when working with scenes with a
large number of static objects.
Mixed – transformation means selection is performed as software based, from the above described.
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4 Routing Audio via Expansion Board FD300
The FD300 board has three stereo inputs and three stereo outputs (or six mono inputs and six mono
outputs accordingly). The cable set or breakout box (connected to the board with a dedicated cable)
have special connectors for the external audio sources and output signals from the FD300 board (see
section 8 of HotActionsLite_User’s Guide).
To adjust the audio routing modes in the Studio for the connected sources, use the Sound Configure
dialog box (Figure 14). To open the dialog box, click the
button on the HotActionsLite main
window toolbar or use the Tools menu. The dialog box provides routing audio from any input to any
output with customizable delays and volumes.
A drop-down list in the Options area (Figure 14, 1) is used to select a board to be adjusted. The
number of items in the drop-down list matches the FD300 boards installed in the system (Figure 1).
Another drop-down list in the Options area (Figure 14, 2) is used to specify a minimum volume for
all the volume sliders in the dialog box (Figure 14, 8, 9). Enabling the Show Meters option (Figure
14, 3) allows you to easily monitor any signal changes in every input and output with the signal level
indicators.
The Curr. Ratio: parameter indicates the current sampling rate (in Hz). The sampling rate of the input
signals matches the output signals. To change the parameter value, launch the FD300Configuration
application (previously close HotActionsLite) and select the required sampling rate from the Internal
processing sample rate drop-down list in the Sound tab (Section 2.1, Figure 14).
All mono inputs of the board are paired to stereo inputs by default (there is a Lock option available for
each pair, see Figure 14, 4). To change the volume level for the resulting input stereo signal, either
volume slider of the pair can be used. The second and third inputs also have the Mic. Boost option
(Figure 14, 5) for additional signal boosting.

Figure 14. Sound Configure dialog box.
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Each audio channel of the board is controlled independently within its group, e.g. the Input1L area
(Figure 14, 6) is used to adjust the first mono input (left channel of the first stereo input).
Among the options of the area is routing the mono input to one of the stereo outputs. For example,
checking the upper check box in the Input1L area (Figure 14, 7) enables routing this mono input to
the first stereo output. The volume slider (Figure 14, 8) allows you to specify the volume level of the
signal routed to the enabled stereo output. When placing the cursor over a routing knob (Figure 14, 9),
the tooltip displays the output where the signal is routed if the corresponding check box on the left is
checked.
By default, the upper check boxes in the mono input areas enable routing to the Line 1 stereo output;
the middle check boxes – to the Line 2 stereo output, and likewise do the lower ones. The matches are
marked with the same color.
By default, the left channel of the first stereo input (Input1L) is completely routed to the left channel
of the enabled stereo output, and the right channel of the first stereo input (Input1R) – to the right
channel of the enabled stereo output. Accordingly, the balance slider of the stereo input left channel is
set by default to maximum left (Figure 14, 10), and the balance slider of the stereo input right channel
is set by default to maximum right.
The Mute option (Figure 14, 11) allows you to completely disable the corresponding input from
routing (Figure 14, 11).
The Delay spin box is used to specify a delay for each mono input in the range from 1 frame to 1
second (in milliseconds) (Figure 14, 12).
Each stereo output has a balance nob (Figure 14, 13), volume slider (Figure 14, 14), and a Mute check
box that allows you to desable the output.

19

